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Predmet: UPRAVLJANJE PROJEKTIMA
Nastavnik: Dr Nándor Burány

6. semestar
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III. DEO
PROSTI PRIMERI PROJEKATA

1. Pripreme za ekskurziju (izvor: www.ecch.com, 
autori: Fraser Johnson i Robert Klassen)

2. Izgradnja �upe (izvor: www.k-
state.edu/infotech/epm/training/MSProject-
101, autori Ashley Wondra, Lloyd Walker i Chuck 
Gould)

3. Uvoðenje novog turistièkog aran�mana (izvor: 
Visoka �kola za projektni menad�ment, Beograd, 
www.vspm-bg.com)
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III-1 PRIPREME ZA EKSKURZIJU

1. Cilj: formiranje prostog softverskog plana 
projekta (projektni fajl, .mpp fajl), 
prouèavanje kritiènog puta, smanjenje 
vremena izvr�avanja.

2. Primer je prost u sledeãem smislu: 
� sve se odigrava u okviru jednog dana
� ceo projekat izvr�ava jedan resurs (èovek)
� ne bavimo se tro�kovima. 

III-1.1 OPIS PROJEKTA
Jovan je uplatio za skijanje od nekoliko dana na kraju 
ispitnog roka. Po planu polaganje poslednjeg ispita 
zavr�ava u petak u 12:00 h, posle toga treba da se 
pripremi na put i treba da stigne na autobus koji kreãe u 
17:00 h. 
Prethodne dane je Jovan proveo u uèenju i nije mogao 
da se bavi pripremama na ekskurziju. Posle ispita treba 
da ode kuãi �to traje pola sata. Nakon toga treba da 
opere tri punjenja ve�a �to traje ukupno èetiri sata. 
Nakon pranja sledi spakovanje stvari, �to zahteva pola 
sata, zatim treba da pakuje stvari u kola i treba da se 
odveze do autobuske stanice �to iziskuje dodatnih pola 
sata po svakoj radnji. U meðuvremenu treba da ode do 
banke da digne novac, �to traje jedan sat. 
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III-1.2 LISTA ZADATAKA

OZNAKA 
AKTIVNOSTI

IME AKTIVNOSTI NEPOSREDAN  
PRETHODNIK

PROCENJENO 
VREME TRAJANJA 

[h]

A ide kuãi - 0,5

B pere ve� A 4,0

C spakuje stvari B 0,5

D ide u banku A 1,0

E stavlja stvari u kola C,D 0,5

F vozi do stanice E 0,5

UPUTSTVO ZA 1. VE�BU: 
OTVARANJE NOVOG FAJLA PROJEKTA, 

SNIMANJE ISTOG, OSNOVNA 
PODE�AVANJA

1. Formiranje i snimanje novog fajla projekta.
2. Provera i pode�avanje osnovnih pode�avanja 

(obavezno se radi pri formiranju novog 
plana).

Softverski plan projekta (fajl projekta, .mpp 
fajl) treba èesto snimati da ne bi izgubili 
une�ene informacije!
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OTVARANJE NOVOG PROJEKTNOG FAJLA

� Dvostrukim klikom na ikonu MS Project-a 
pokrenimo softver!

� Po potrebi zatvorimo prozore New Project i 
Tasks!

� Formirani prazan fajl projekta snimimo
komandom Save As. Za ime fajla treba upisati 
Pripreme za ekskurziju.mpp.

PODE�AVANJE VREMENSKE SKALE

� Komandom Format|Timescale otvorimo prozor 
Timescale!

� Klikom na jezièak Top Tier, na kartici koja se 
prikazuje opciju Show podesimo na Three Tiers!

� Kilom na jezièak Bottom Tier, opciju Units 
podesimo na Minutes, a opciju Count na 30 
(minuta).

� Klikom na jezièak Middle Tier, opciju Units 
podesimo na Hours, a opciju Count na 1!

� Snimimo projektni fajl!
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1. ve�ba: 
Formiranje novog fajla projekta, 

snimanje istog i vr�enje osnovnih 
pode�avanja

� Izvedimo ve�bu!

9

UPUTSTVO ZA 2. VE�BU:
UNOS I SREÐIVANJE ZADATAKA

1. Uno�enje zadataka iz kojih se projekat sastoji  
u prethodo formirani fajl projekta.

2. Zadavanje trajanja zadataka.

3. Definisanje logièkih zavisnosti.
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UNOS ZADATAKA

� Otvorimo fajl projekta Pripreme za ekskuziju.mpp 
(ako veã nije otvoren).

� Birajmo (prikaz) Task Sheet View. 

� U dobijenoj tabeli u prvu vrstu kolone Resource 
Name upi�imo Ide kuãi, zatim pritisnemo dugme 
Enter.

� U naredne vrste na isti naèin upi�imo nazive 
ostalih zadataka (Pere ve�, Spajuje stvari, Ide u 
banku, Stavlja stvari u kola, Vozi do stanice).

ZADAVANJE TRAJANJA ZADATAKA

� U kolonu Duration, u odgovarajuãe vrste 
upi�imo trajanje pojedinih zadataka u satima, 
na pr. kod zadatka Ide kuãi upi�imo 0.5h, kod 
Pere ve� 4h itd. 
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DEFINISANJE LOGIÈKIH ZAVISNOSTI

� U kolonu Predecessor za svaki zadatak upi�imo 
redni broj zadatka prethodnika, na pr.: kod 
zadatka Pere ve� upi�e se 1, kod zadatka 
Spakuje stvari upi�e se 2 itd. Redni broj 
zadatka je naveden u prvoj koloni tabele Task 
Sheet.

� Snimimo fajl projekta!

2. ve�ba: 
Unos i sreðivanje zadataka

� Izvedimo ve�bu!

14
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UPUTSTVO ZA 3. VE�BU:
PROUÈAVANJE KRITIÈNOG PUTA

1. Kritièni put na mre�nom dijagramu.

2. Kritièni put na Gantt-ovom dijagramu.

KRITIÈNI PUT NA MRE�NOM 
DIJAGRAMU

� U meniju View birajmo kliknimo na dugme 
Network diagram. Time prelazimo na prikaz sa 
mre�nim dijagramom.

� Po fabrièkom pode�avanju kritièni zadaci su na 
mre�nom dijagramu oznaèeni sa crvenim 
pravougaonikom. 

� Na kritiènom putu su i strelice koje oznaèavaju 
logièke zavisnosti, takoðe crvene boje. 

� Pravougaonici koji oznaèavaju nekritiène 
zadatke i strelice na nekritiènom putu su plave 
boje.
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KRITIÈNI PUT NA GANTT-OVOM 
DIJAGRAMU

� Vratimo se na Gantt-ov dijagram (u meniju View kliknimo na 
dugme Gantt Chart)! Ako su linije koje oznaèavaju zadatke van 
vidnog polja, klikom na Scroll to task ikonu skaèemo na 
odgovarajuãu poziciju.

� U prozoru Format|Text Styles kod taèke Items to Change birajmo 
opciju Critical Tasks, zatim kod taèke Color birajmo opciju Red)! 
Pritiskom na dugme OK zatvaramo prozor. Imena zadataka koji su 
na kritiènom putu prikazaãe se u crvenoj boji.

� Linije na Gantt-ovom dijagramu koje odgovaraju kritiènim 
zadacima se mogu promeniti u crveno primenom èarobnjaka koji 
se pokreãe komandom Format|Gantt Chart Wizard.

� U ovom projektu ne razlikujemo sumarne i obiène zadatke, zato 
su sve aktivnosti prikazane sa linijama istog tipa.

� Po �elji mo�emo prikazati sumarni zadatak projekta. To se dobija 
izborom jezièka View u prozoru Tools|Options. Na kartici View 
ukljuèimo opciju Show project Summary task!

3. ve�ba: 
Prouèavanje kritiènog puta

� Izvedimo ve�bu!

18
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UPUTSTVO ZA 4. VE�BU:
PODE�AVANJA NA PROJEKTU RADI 

PO�TOVANJA ROKA

Vreme za pripreme prema formiranom planu 
projekta iziskuje �est sati. Na �alost, na 
raspolaganju nam je svega pet sati. U principu, 
metode za skraãivanje vremena izvr�avanja 
projekta su:

1. Paralelno izvr�avanje zadataka.

2. Smanjivanje obima projekta.

PARALELNO IZVR�AVANJE ZADATAKA

� Paralelovanje izvr�avanja odreðenih zadataka je 
�iroko poznata metoda za skraãivanje roka 
izvr�avanja projakta. 

� U formiranom planu projekta veã su paralelovani 
oni zadaci kod kojih je to bilo moguãe uraditi (ide 
u banku dok ma�ina pere ve�).

� Zadr�avanje u banci se mo�e skratiti ako 
nazovemo banku i dogovorimo planiranu 
transakciju i banka unapred pripremi potrebna 
dokumenta. Na �alost to neãe skratiti vreme 
izvr�avanja projekta jer odlazak u banku nije 
zadatak na kritiènom putu.
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SMANJENJE OBIMA PROJEKTA

� Manje rada na projektu zahteva manje 
vremena za izvr�avanje. 

� Ako umesto tri punjenja operemo samo dva 
punjenja, vreme pranja se mo�e skratiti na 2/3 
od dosada�njeg (2h 40min).

� Kliknimo u Duration koloni na polje u vrsti 
Pere ve� i upi�imo 2.66h umesto 4.0h.

� Time je du�ina kritiènog puta smanjena ispod 
pet sati, �to se uklapa u postavljeni rok. 

4. ve�ba: 
Pode�avanja na projektu radi 

po�tovanja roka

� Ivedimo ve�bu!

22
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KRAJ 1. PRIMERA: 

PRIPREME ZA EKSKURZIJU

III-2 IZGRADNJA �UPE

1. Cilj: izrada prostog softverskog plana 
projekta, snimanje baznog plana i praãenje 
napredovanja projekta.

2. Jednostavnost primera se ogleda u sledeãem: 

� mali broj zadataka i resursa,

� proste logièke zavisnosti,

� nema striktnog roka i finansijskih 
ogranièenja.
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CILJEVI
Ve�be vezane za primer Izgradnja �upe ãe 
pripremiti kandidata za obavljanje sledeãih 
operacija:
� pravilno kreiranje dokumetacije projekta,
� uno�enje svih detalja u vezi zadatka,
� definisanje trajanja zadataka,
� meðusobno povezivanje zadataka,
� dodela resursa zadacima,
� snimanje baznog plana,
� upravljanje projektom i praãenje 

napredovanja projekta.
25

OPIS ZADATKA PROJEKTA

� Treba nam jedna �upa u kojoj mo�emo 
smestiti na�e alate za ba�tu �to smo dosad 
dr�ali u gara�i. 

� �upa ãe se graditi od kompleta koji ãe se 
nabaviti od firme Home Depot.
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DEFINISANJE OBIMA PROJEKTA 
(ZAHTEVI)

� Zidovi treba da budu visine 8 ft (stopa) predviðena povr�ina 
je 120 sq. ft (kvadratne stope),  potrebno je postaviti 
prozore dimenzije 2ftx3ft na svakoj strani objekta.

� Ulazna vrata treba da budu velièine 7ft.x8ft., predvideti 
bravu.

� �upu treba pokrivati sa istim materijalom kojom je 
pokrivena i kuãa da bi se dobro slagale. Isto se odnosi na 
zidove.

� Krajeve rogova ne treba skraãivati, ispod njih mo�emo  
napraviti dodatni skladi�ni prostor. Pod treba izbetonirati.

� Lokacija: jugozapadni ugao u zadnjem delu dvori�ta.
� Procenjena vrednost radova je 1.250$.
� Procenjeno vreme trajanja projekta: jedan mesec (s time da 
ãemo raditi samo èetvrtkom i petkom).

LJUDSKI RESURSI

� Andy Handy � iznajmljeni radnik, radi za 
satnicu od 25$,

� Betty Doe (kãerka vlasnika) � radi za satnicu od 
10$,

� Frank Doe (sin vlasnika)  � radi za satnicu od 
10$,

� John Doe (vlasnik) � radi za satnicu od 0$.
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PLAN IZGRADNJE KORAK PO KORAK - 1
� Naruèiti komplet i zakazati isporuku (u prvoj nedelji)

� Trajanje: 1 dan, sati: 2, radnik: John

� Priprema (sumarni zadatak)

� Priprema lokacije � oèistiti i izravnati povr�inu (u prvoj nedelji)

� Trajanje: 2 dana, sati: po 12 svaki radnik, radnici: Betty, Frank, 
John

� Izlivanje betonskog temelja (u drugoj nedelji)

� Trajanje: 1 dan, sati: po 5 svaki radnik, radnici: John, Andy

� Primanje isporuke kompleta

� Trajanje: 1 dan, sati: 2, radnik: John

� Postavljanje isporuke kompleta kao kljuènog zadatka

� Trajanje: 0 dana, sati: 0, radnik: niko

PLAN IZGRADNJE KORAK PO KORAK - 2

� Sklapanje (sumarni zadatak)

� Sklapanje kompleta (u treãoj nedelji)

� Trajanje: 1 dan, sati: po 5 svaki radnik, radnici: John, Andy

� Farbanje �upe

� Trajanje: 1 dan, sati: po 2 svaki radnik, radnici: Frank, Betty

� Ureðivanje travnjaka/ cvetnjaka oko �upe

� Trajanje: 1 dan, sati: 4, radnik: Betty

� Sme�tanje alata i opreme u �upu (u èetvrtoj nedelji)

� Trajanje: 1 dan, sati: po 5 svaki radnik, radnici: John, Frank
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UPUTSVO ZA 1. VE�BU: 
OTVARANJE NOVOG PROJEKTNOG FAJLA, 

SNIMANJE, OSNOVNA PODE�AVANJA
1. Kreiranje i snimanje novog softverskog plana 

projekta,
2. Pode�vanja u prozoru Project Information,
3. Kontrola i po potrebi promena fabrièkih 

pode�avanja (obavezno se radi pri kreiranju 
novog plana),

4. Dodavanje novih kolona u tabele.
Softverski plan projekta (projektni fajl, .mpp 
fajl) treba èesto snimati u pojedinim fazama da 
ne bi do�lo do gubitka informacija!

Osnovne informacije o projektu 
(Project Information dialog box)

32
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Standardni parametri 
(Tools → Options), kartica Schedule

33

Standardni parametri, 
kartica View

34



4/14/2009

18

Kalendari projekta (Tools→Change 
Working Time)

35

Izbor prikaza (View) i dodavanje kolona 
� Task Sheet view (View → More Views → Task Sheet 

view),
� dodavanje i sakrivanje kolona po potrebi,

� preporuèuje se prikazivanje sledeãih kolona:

� naziv zadatka (Task Name)

� procentualna vrednost izvr�enja zadatka (% Complete)

� trajanje zadatka (Duration),

� planirana kolièina rada (Work),

� poèetni datum (Start),

� zavr�ni datum (Finish),

� resursi (Resources).
36
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1. ve�ba: Otvaranje novog projektnog 
fajla, snimanje, osnovna pode�avanja

� Izvedimo ve�bu!

37

UPUTSTVO ZA 2. VE�BU:
UNOS I ORGANIZOVANJE 

ZADATAKA

1. Unos zadataka od kojih se sastoji projekat u 
pripremljeni fajl projekta,

2. Sreðivanje unetih zadataka (definisanje 
sumarih i obiènih zadataka).
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Organizovanje zadataka

� glavni sumarni zadatak (pokriva ceo projekat),

� sumarni zadaci (znaèajnije faze projekta),

� podzadaci (konkretne aktivnosti),

� naèini dodeljivanja resursa zadacima (tipovi 
zadataka): veza izmeðu kolièine rada, nivoa 
anga�ovanja resursa i trajanja izvr�avanja 
zadatka.

39

Glavni sumarni zadatak projekta

� Glavni sumarni zadatak ima jedinstvene 
karakteristike:

� ID = 0

�Unique ID = 0

�Outline Level = 0 

� Summary = Yes

� Jedino glavni sumarni zadatak mo�e da se
kreira na Outline Level = 0.

40
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Sumarni zadaci

41

Podzadaci

42
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Tipovi zadataka:
Veze izmeðu kolièine rada, nivoa anga�ovanja resursa i 

trajanja izvr�avanja zadatka

� Fiksne jedinice (Units) � zadaci gde resursi imaju fiksni nivo 
anga�ovanja (Units) i gde promene kolièine rada (Work) ili 
trajanja zadatka (Duration) ne utièu na nivo anga�ovanja 
resursa.

� Fiksni rad � zadaci gde kolièina rada ima fiksnu vrednost i
promene trajanja zadatka ili broja resursa ne utièu na kolièinu 
rada.

� Fiksno trajanje (preporuèeno, standardno pode�avanje) � zadaci 
gde trajanje zadatka ima fiksnu vrednost i promene kolièine rada
ili broja resursa ne utièu na trajanje.

� Planiranje upravljano usiljenim anga�ovanjem�trajanje zadatka 
se skraãuje ili produ�ava kako se resursi dodaju ili uklanjaju iz 
zadatka, dok ulo�eni trud (rad) u zadatku ostaje isti.

43

Izbor tipa zadatka

44
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2. ve�ba: Unos i organizovanje 
zadataka

� Izvedimo ve�bu!

45

UPUTSTVO ZA 3. VE�BU:
UNO�ENJE DODATNIH 

INFORMACIJA U VEZI ZADATAKA

1. Pode�avanje ogranièenja,

2. Zadavanje trajanja aktivnosti,

3. Ruèno pode�avanje logièkih zavisnosti,

4. Istovovremeno pode�avanje logièkih 
zavisnosti kod vi�e zadataka,

5. Fino pode�vanje logièkih zavisnosti 
dodavanjem ka�njenja.
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Informacije o zadatku

Rad u prozoru Task Information:

� definisanje kljuènih zadatka,

� trajanja,

� ogranièenja,

� relacije izmeðu zadataka.

47

Prozor Task Information, 
kartica General

48
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Prozor Task Information, 
kartica Predecessors

49

Prozor Task Information, 
kartica Resources

50
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Prozor Task Information, 
kartica Advanced

51

Prozor Task Information, kartica Notes: 
pisanje bele�aka

52
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Prozor Task Information, 
kartica Advanced: definisanje kljuènih 

zadataka (Milestone)

53

Oèekivano trajanje zadatka

� prozor Task Sheet, kartica  General,
� Prilikom unosa trajanja (Duration) zadatka, 

potrebno je uneti oèekivano (planirano) vreme 
za izvr�avanje zadatka.

� Moguãe jedinice trajanja zadatka su:
� m = minuti,
� H = sati,
� D = dani,
� W = nedelje,
� M = meseci.

54
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Vrste vremenskih ogranièenja u vezi 
izvr�avanja zadataka

� prozor Task Sheet, kartica  Advanced, polje Constraints,
� vrste ogranièenja (Constraints):
� najkasnije moguãe (as late as possible),
� najranije moguãe (as soon as possible),
� ne zavr�iti ranije od (finish no earlier than),
� ne zavr�iti kasnije od (finish no later than),
� mora da se poène u dato vreme (must finish on),
� mora da se zavr�i u dato vreme (must start on),
� ne poèeti ranije od (start no earlier than),
� ne poèeti kasnije od (start no later than),

55

Relacije izmeðu zadataka

� prozor Task Information, kartica Predecessor, polje 
Type,

� Vrste relacija:

� zavr�i da bi zapoèeo (FS - finish to start, to je 
standardna, najèe�ãe primenjena relacija),

� zapoèni da bi zavr�io (SF - start to finish),

� zapoèni da bi zapoèeo (SS - start to start),

� zavr�i da bi zavr�io (FF - finish to finish).

56
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3. ve�ba: Uno�enje dodatnih 
informacija u vezi zadataka

� Izvedimo ve�bu!

57

UPUTSTVO ZA 4. VE�BU:
UNOS RESURSA

1. Upisivanje imena resursa,

2. Definisanje tipa resursa,

3. Dodeljivanje tro�kova resursima,

4. Dodeljivanje resursa  zadacima,

5. Unos procenjenih vremena izvr�avanja 
zadataka.
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Resursi

� vrste resursa,

� uno�enje resursa,

� dodeljivanje (rasporeðivanje) resursa 
zadacima,

� shvatanje pojma "rad".

59

Tipovi resursa
� radni resursi (ljudi pojedinaèno ili timovi ljudi),
� resursi tipa oprema (radne ma�ine, raèunarski 

hardver, prostorije...),
Dva gornja tipa resursa u MS Project-u se vode 
kao resursi tipa Work (rad).
� materijalni resursi (potro�ni materijal koji se 

koristi),
� tro�kovni resursi (putovanja i slièno �to nije 

direkno vezano za rad projektu ali predstavljaju 
tro�ak).

60
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Uno�enje resursa
� preporuèljivo je uneti resurse nakon �to su zadaci 

uneti i povezani,

� dodeljivanje imena (Resource Name) i nivoa 
anga�ovanja (Units) za svaki resurs,

� trajanje zadatka (Duration) je oèekivana kolièina 
vremena potrebna da se kompletira odreðeni 
zadatak, izra�ena u danima,

� planirani rad (Work) je kolièina napora (truda)
potrebna da bi se kompletirao zadatak, izra�ena
u satima.

61

4. ve�ba: Unos resursa

� Izvedimo ve�bu!

62
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UPUTSTVO ZA 5. VE�BU:
SNIMANJE BAZNOG PLANA I 

UNO�ENJE NAPREDOVANJA NA 
PROJEKTU

Formiranjem plana projekta upravljanje 
projektom nije zavr�eno.

Dalje akcije su:

1. Snimanje baznog plana

2. Praãenje napredovanja na projektu

Praãenje napredovanja posla na 
projektu (Tracking)

� snimanje baznog plana projekta,

� uno�enje stvarnih informacija o napredovanju.

64
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Snimanje baznog plana projekta

� svrha snimanja baznog plana,

� kako uraditi?
� Tools → Tracking → Save Baseline

� ne zaboraviti snimiti bazni plan celokupnog 
projekta (opcija Entire project)!

65

Uno�enje stvarnog rada na projektu

� otvoriti prikaz Task Sheet,

� uneti stvarni poèetak rada,

� eliminisati ograniéenja ako je potrebno,

� uneti stvarno trajanje zadatka,

� podesiti izvr�enost (% Complete) zadatka na 
100%,

� redosled uno�enja podataka je VEOMA bitan.

66
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5. ve�ba: Snimanje baznog plana i 
uno�enje napredovanja na projektu

� Izvedimo ve�bu!
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UPUTSTVO ZA 6. VE�BU:
PRIKAZI, TABELE, FILTRI

� najèe�ãe kori�ãeni prikazi (Views):

�prikaz Task View,

�prikaz Gantt Chart,

�prikaz Tracking Gantt,

� samostalno kreirani prikazi.

� tabele (Tables),

� filtri i grupe (Filters, Groups).
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Prikaz Task Sheet

� èesto se koristi kao baza za razne izve�taje,

� najèe�ãe se koristi pri samostalnom kreiranju 
izve�taja.

69

Prikaz Gantt Chart

70
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Prikaz Tracking Gantt

71

Samostalno kreirani prikazi

� Prikazi su saèinjeni od
� tabela,

� rezulata filtriranja,

� grupisanja.

� Preporuèljivo je kopirati prikaz kao i sve 
tabele, filtere i grupe koji doprinose tom 
prikazu.

72
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Tabele

� Tabele omoguãavaju prikaz podataka preko 
kolona i vrsta.

� Tabela èuva informacije i u vezi konstrukcionih 
detalja (naèina definisanja) tabele.

73

Filtri i grupe

� Filtri - naèin odabira podskupa zadataka za
prikaz.

� Grupe - naèin organizovanja redova zasnovan
na njihovom sadr�aju (u zavisnosti od njihovog 
sadr�aja).

� Filtri i Grupe se mogu koristiti zajedno za 
ureðivanje podataka ili mogu biti upotrebljeni 
pojedinaèno (nezavisno jedno od drugog).

� Filtri i Grupe se mogu kreirati upotrebom 
jednog ili vi�e uslova.

74
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6. ve�ba: Prikazi, tabele, filtri

� Izvedimo ve�bu!

75

KRAJ 2. PRIMERA: 

IZGRADNJA �UPE
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III-3 UVOÐENJE NOVOG 
TURISTIÈKOG ARAN�MANA

1. Cilj: Kratak prikaz plana projekta onog nivoa 
kakav se oèekuje kao ispitni rad iz ovog 
predmeta.

2. Primer je prost u sledeãem smislu: 
� mali broj resursa radi na projektu (3+)
� bud�et nije striktno odreðen (ogranièen).
� ne koristi se nikakva oprema  sa znaèajnim 

tro�kovima.

III-3.1 OPIS PROJEKTA
� Rukovodstvo agencije Follow me � NIS Jugopetrol 

tourism je kori�ãenjem rezultata analize tr�i�ta do�lo 
do zakljuèka da je potrebno uneti novine u postojeãu 
ponudu. Novim projektom odluèeno je da se pa�nja 
usmeri na omladinu. Usled velikog interesovanja 
mladih za ekskurzije, kao najatraktivnija izdvojila se 
relacija Francuska - �panija � Italija. 

�

� Uvoðenje novog turistièkog aran�mana u ponudu ima 
svoje ciljeve, rokove, kompleksnost, resurse, 
organizacionu strukturu i obuhvat zbog èega ãe se 
tretirati kao projekat. Usled ovoga i potrebe za daljim 
razvojem u agenciju se uvodi koncept upravljanja 
projektom. 
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III-3.2 CILJEVI PROJEKTA -
KRITERIJUMI USPEHA

� Cilj 1 � Zavr�etak projekta do 11.11.2007.

� Cilj 2 � Uvoðenje aran�mana kao dela stalne 
ponude.

� Cilj 3 � Uspostavljanje veza sa novim inostranim 
saradnicima i potpisivanje ugovora sa njima.

� Cilj 4 � Realizacija projekta u okviru odobrenog 
bud�eta.

III-3.3 ORGANIZACIONO-TEHNIÈKA 
STRUKTURA - WBS DIJAGRAM
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III-3.4 ZADACI PROJEKTA - SUMARNI 
ZADATAK PRIPREMA

1. Priprema

1.1.  Ocena opravdanosti

1.2. Koncipiranje ideje

1.2.1. Specifikacija projektnih zahteva

1.3. Razrada koncepta

1.3.1. Utvrðivanje ciljeva

1.3.2. Utvrðivanje kriterijuma

1.3.3. Utvrðivanje obuhvata (obima)

III-3.5 ZADACI PROJEKTA - SUMARNI 
ZADATAK LOGISTIKA

2. Logistika
2.1. Uspostavljanje veze sa ambasadom
2.2. Pronala�enje hotela

2.2.1. Prikupljanje informacija o hotelima
2.2.2. Izbor potencijalnih hotela
2.2.3. Kontaktiranje hotela 

2.3. Pronala�enje prevoznika
2.3.1. Prikupljanje informacija o prevoznicima
2.3.2. Izbor prevoznika
2.3.3. Kontaktiranje prevoznika

2.4. Obezbeðenje viza
2.5. Obezbeðenje hotela

2.5.1. Rezervisanje
2.5.2. Ugovaranje

2.6. Obezbeðenje prevoznika
2.6.1. Rezervisanje
2.6.2. Ugovaranje
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III-3.6 ZADACI PROJEKTA - SUMARNI 
ZADATAK IZRADA PROGRAMA

3. Izrada programa

3.1. Odreðivanje datuma

3.2. Utvrðivanje itinerera puta

3.3. Utvrðivanje fakultativnih izleta

3.4. Obezbeðivanje kadrova

III-3.7 ZADACI PROJEKTA - SUMARNI 
ZADATAK OPERATIVNA REALIZACIJA

4. Operativna realizacija
4.1. Plasman aran�mana

4.1.1. Kreiranje marketing strategije
4.1.2. Priprema propagandnog materijala
4.1.3. Sprovoðenje marketing strategije
4.1.4. Promocijske aktivnosti
4.1.5. Anketiranje zainteresovanih

4.2. Izvoðenje aran�mana
4.2.1. Evidencija putnika
4.2.2. Organizacija polaska
4.2.3. Izvoðenje utvrðenog plana 
4.2.4. Regulisanje obaveza pri povratku

4.3. Operativno izve�tavanje
4.3.1. Sumarni prikaz rezultata
4.3.2. Predaja dokumentacije
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III-3.8 KLJUÈNI DOGAÐAJI

UPUTSTVO ZA 1. VE�BU:
ANALIZA BAZNOG PLANA

� Otvoriti fajl Follow me - Osnovni plan!
� Pogledati koje informacije su prikazane u tabelarnom 

delu Gantt-ovog prikaza!
� Na Gantt-ovom dijagramu locirati sumarne zadatke, 

obiène zadatke, logièke zavisnosti i kljuène dogaðaje!
� Komandom Project|Filtered for|Summary tasks sakriti 

obiène zadatke (da budu prikazani samo sumarni 
zadaci), zatim ih ponovo otkriti!

� Kritiène zadatke na Gantt-ovom dijagramu prikazati sa 
crvenim trakama (Format|Gantt Chart Wizard)!
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1. ve�ba: Analiza baznog plana

� Izvedimo ve�bu!

87

UPUTSTVO ZA 2. VE�BU:
ANALIZA PRAÃENJA NAPREDOVANJA

� Otvoriti fajl Follow me - Aktualizacija 
osnovnog plana, 22.02.2005!

� Uoèite razlike u trakama na Gantt-ovom 
dijagramu do 22.02 i posle tog datuma!

� Otvoriti prikaz Tracking Gantt (View|Tracking 
Gantt)!

� Uoèite ka�njenja kod izvr�avanja pojedinih 
zadataka!
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2. ve�ba: Analiza praãenja 
napredovanja

� Izvedimo ve�bu!
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KRAJ 3. PRIMERA:

UVOÐENJE NOVOG 

TURISTIÈKOG ARAN�MANA
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Rezime

� Ovo je bilo samo vrh ledenog brda 
(softver ima mnogo vi�e moguãnosti 
nego �to je ovde prikazano).
� MS Project 2007 je alat koji olak�ava

planiranje, ali koji ne mo�e planirati 
umesto vas.
� Potrebno je ulo�iti znaèajan trud da bi 

se savladalo kori�ãenje ovog alata 
(kursevi, literatura, ve�be)
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KRAJ III. DELA

(Prosti primeri projekata)
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